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Practical 3 
Learning objectives:   

 To work with Vector Data in a GIS.  

 To practise selecting data using a GIS.  

 To learn how to use one layer to interact with another.  

 To use a GIS to produce a proper printable map. 

 

Selecting data: Getting layers to interact.  
We will create a map showing the location of a set of settlements in the UK. We will practise 

how to select the points based on certain criteria.  We will then use the point layers attributes 

to create a choropleth map of the UK and use this map to produce a print quality PDF. 

 

Part 1: Creating a shapefile for analysis 

1. Open a “new map file” by clicking on the  Icon in the top left corner of the interface.   

You cannot have two map files open at the same time in ArcGIS so if you have still got 

Practical 2 open it will ask you to save changes and close it. 

We will need to set the projection for the layer again using the same process as before.   

2. Right click on the Layers icon at the top of the table of contents then click on the 

Properties item at the bottom. 

3. In the data frame properties dialogue box, click on the Coordinate System tab and in 

the Select a Coordinate System part navigate to the British National Grid by clicking 

on the following folders: 

Predefined  Projected Coordinate Systems  National Grids  

Europe  British National Grid 

Now you can begin to bring in the vector data to ArcMap.   

4. Click on the Add Data button on the tool bar:    

You should already be connected to the Intro to Visualising Data directory so select it from 

the list.  

5. Double click on Practical 3 to open it.  
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6. Add the gazetteer_thorpe.csv file. 

NOTE: This file is a list of points that was downloaded from the Gazetteer Plus facility in 

Digimap. This facility allows you to select parts of the 1:50,000 scale gazetteer to download 

based on a list of search criteria.  You can also specify which attributes each entry should 

include. This particular file was created by searching for all the features in England that’s 

names end with …Thorpe.  The attribute columns were limited to Easting, Northing, County 

Name and Feature Type. 

To view the data on the map we will need to use the Add X Y Data function again: 

7. Right-click on the gazetteer_thorpe.csv in the table of contents and select Display XY 

Data. 

8. Set the X field to Eastings and the Y field to Northings.  

9. Click OK. 

You will receive the warning message as in Practical 1: 

 



Using Spatial Data in a Desktop GIS; ArcGIS 10.1      Practical 3 
 
 

EDINA and Edinburgh University Data Library   37 

10. This time we will Export this file in the next step. Click OK. 

11. A new layer should be added to the Table of Contents called gazetteer_thorpe.csv 

Events. As we won’t be able to select from this Events layer we will need to export it 

to a new Shapefile. 

12. Right-click on the Events layer and select Data  Export Data. 

 

13. A new pop-up will open called Export Data. 

14. Export:  All features. 

15. Use the same coordinate 

system as this layer’s source 

data. 

16. Browse to the Practical 3 

folder and call the file Thorpes.shp 

17. Click OK. 
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18. Once the file has finished 

processing click Yes to add it as 

a layer on the map. 

 

 

 

You have now created an entirely new shapefile containing all the information from the CSV 

file along with geometry information to draw the points.  You need to carry out this export 

process if you want to do any kind of analysis with the data, though it isn’t necessary to just 

symbolise the points. 

You can remove the .csv Events file without affecting the map or the new shapefile you 

have created. 

19. Right-click on the gazetteer_thorpe.csv Events file in the table of contents and 

select Remove. 

 

At this point it is also a good idea to save our map again; do this in the same way as before:  

20. Click File then Save as. 

21. Save the file in the same folder as the data: Intro to Visualising Data. 

22. Replace untitled with a suitable name such as Practical 3. 
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Part 2: Selecting features based on their attributes 

Once you have created a Shapefile you can then use the GIS software to select features.  

Selected features can be manipulated separately from the rest of the features in the layer. 

They can be used in further analysis or have their attributes updated independently from the 

rest of the layer. 

 

The first way we are going to select features is by their attributes.  This is done in exactly the 

same way as database software. 

 

1. Click on the Selection menu in the top bar and click on the first option, Select by 

Attributes. 

 

2. A new window will open allowing you to: 

a. choose the layer you want to select from,  

b. what you want to do with the features you select, 

c. and then there are a few lists that will help you build your selection query.  
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3. The Thorpes shapefile is the only available layer to select from so this choice is 

made for you. 

4. The method we want to use is Create a new selection, this should be the default 

though the other options are often very useful.   

Above the bottom box is the start of your database query: 

SELECT * FROM Thorpes WHERE: 

If you are confident in the database language SQL you can continue the query yourself in 

this box.  However, it is much easier to use the predefined field names, operators and 

attributes. 

A simple query to try is Select *(all attributes) from Thorpes (data table name) where 

“Countyname” (a column heading) = (or any Boolean operator from the buttons in the 

interface) ‘Essex’ (one of the Attributes found in the column you have chosen). 

You can get a list of all the Attributes in a column once you have selected it for the query, just 

click on Get Unique Values.  This is not a good idea on a large table where all the values in 

the column you have selected are different. 
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5. Double Click “Countyname” in the top list, it will be added into the query. 

6. Click the = button. 

7. Click on the Get Unique Values button to populate the lower list with attributes for 

Countyname column. 

8. Double-click ‘Essex’ 

9. Click Apply; notice that the three points in Essex are highlighted in turquoise on the 

map. 

10. Click OK to close the Selection By Attributes window. 

 

You have now selected all the towns with names ending in Thorpe in Essex based on their 

attributes.  However it isn’t always possible to do this as the attributes may not contain the 

information you want to select by. The next section will show you how to make some 

selections using location. 

11. Save your work and we can then move on to the next section.  
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Part 3: Selecting features based on their location 

The easiest way to select features by their location is to use the Select Features Tool to drag 

a box around the ones you want. 

1. Click on the Select Features icon above the map:  

2. Drag a box around a set of points 

 

3. These features will now be selected in the data table. 

This is a very quick way to select a group of points but it isn’t always possible to get the ones 

you want if they are densely grouped or you have a complex boundary to select them by.  

We are now going to add in a set of county boundaries and use them to select the points. 

4. Click on the Add Data icon on the tool bar:    

5. Add the England_ct_1981_area.shp file from the Practical 3 subfolder.  
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NOTE: This is a set of County boundaries from 1981 before the introduction of Unitary 

Authorities. These were chosen as they are large simple polygons. They are probably not 

appropriate for current research unless your other data is from this time period. We can now 

use these polygons to select the settlement points but first we need to clear the selection we 

have made already. 

6. Right-click on the Thorpes file in the table of contents. 

7. Select the Selection option and then Clear Selected Features, as shown in the 

picture below. 
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We can now use pick a county and select the points within it: 

8. With the Select Features tool  point and click in the county of Norfolk. 

 

9. Go back to the Selection menu above the map and click on Select By Location. 
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10. The Select By Location window will now open. 

11. You want to select features from the 

following layer(s):Thorpes. 

12. Using the Source Layer: 

England_ct_1981_area 

13. Make sure you check the box for Use 

selected Features. 

14. The Spatial selection method for 

target layer feature(s) to pick from the 

drop down menu is: are completely 

within the source layer feature. 

15. Click Apply and OK. 

 

 

 

You have now selected all the settlements with place names that end with thorpe in the 

county of Norfolk. You could now export these to a new shapefile or add or change their 

attributes for example.  
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Part 4: Joining layers based on their location 

In the next part of the exercise we are going to perform a spatial join between the settlement 

points to the Counties. This operation will join the attributes of one layer to features in the 

other layer based on their location. You can also automatically add summary attributes 

where multiple features in one layer join to a single feature in the other. 

In this instance we are looking to create a field in the Counties dataset that has a count of 

the number of Thorpe points. This means we will be able symbolise the Counties by the 

number of Thorpe settlements they contain. 

1. Right-click on the Thorpes file in the table of contents. 

2. Select the Selection option and then Clear Selected Features 

3. Repeat this for the England_ct_1981_area file. 

4. Right-click on the England_ct_1981_area and select Joins and Relates and then 

Join… 

 



Using Spatial Data in a Desktop GIS; ArcGIS 10.1      Practical 3 
 
 

EDINA and Edinburgh University Data Library   47 

5. The Join Data window will open as shown below: 

6. We want to Join data from another 

layer based on spatial location. 

7. Select the Thorpes layer if it isn’t 

already. 

8. We want to use the first option in part 

two as it is the count field we are 

interested in.  

9. We don’t need a summary of any of 

the other attributes of the points though 

these may be important for your own 

research so have a look. Leave all the 

boxes unchecked. 

10. In part three browse to the Practical 

3 folder and save the new output file as 

Counties_Thorpes.shp. 

 

11. There will be a brief message showing the progress of the join then the new shapefile 

will be added to the map. 

The new data will look exactly the same as the counties data set but if we look in the attribute 

table we can see new columns. 

12. Right –click on the Counties_Thorpes file in the Table of Contents and select Open 

Attribute Table. 
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13. The Attribute Table will open and you should be able to see the count field at the end. 

 

We can use the Count field to colour the map like we did with the deprivation scores earlier. 

14. Right-click on Counties_Thorpes in the table of contents and click on Properties. 

15. Select the Symbology tab. 

16. Click Quantities on the left and select Graduated colors. 

17. Change the Fields Value: to be Count_ and the number of Classes to be 6. 
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This is the end of the basic exercises, 

there is one further part if you have time. 

 

18. Change the Color Ramp: to one that you like the best. 

19. Click Apply and OK. 

 

The resulting map gives a great indication of the distribution of the Thorpe settlements 

across England and could allow you to make inferences as to where the Vikings might have 

settled first and where they then spread to. 

20. Save your work and then move on to the next section  
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The following exercise can be done if you have time: 

Part 5: Working with Layouts in ArcMap 

The following instructions show you how to get your map ready for printing. You can also use 

these instructions to export a map image to use in a presentation or website. 

The default “view” within ArcMap is the data view. Click on View in the Menu bar and change 

to Layout View. 

 

You are now working in the layout environment, a new tool bar will appear and your map will 

be shown within a box inside of another box that looks like a page. 
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The new tool bar has a new set of tools that allow you to zoom in and out on the page and 

move its elements around without changing the view on the data.  

 

If you use the tools on the normal tool bar you will move the data and so not all of it may be 

present on the printed page. If you get into trouble then click on the globe icon   in the 

normal tool bar to view the maximum extent of your data and the whole page icon  in 

the layout toolbar to view all of your page layout. To resize and select different features on 

the map you must have the pointer  selected in the normal tool bar.  

We can now get started on producing a proper map for printing: 

1. Resize the map area with the corner 

handles. 

2. Arrange the map so there is room for a title 

above it. 

 

 

 

 

 

 

 

 

 

Warning: changes can be slow. Watch the spinning planet at the bottom of the window to 

see that the program is still working. 

A map isn’t really a map if it only consists of a picture. A number of cartographic entities are 

needed before we can really call our creation a map, namely: A Title, Scale bar, North Arrow 

and Legend. 

The following sections show how to add all these features to your map. 
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Part 5.1 Adding a Title 

1. Click Insert on the Menu Bar and select Title which will open the Title box.  

 

2. Type in an appropriate title, such as “Distribution of Viking Settlements: …thorpe”. 

 

3. Click OK and the title will be added to the map.  

4. Double click on the title to open the properties box, here you can edit things like the 

font and size. Use the Change Symbol… button to do this in the simplest way. 
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Part 5.2 Adding a Legend 

There is a wizard to take you through the creation of the legend; for this example there is no 

need to change any of the settings unless you want to.  However, before you start it is good 

to make a few changes to the data layer names in the Table of Contents. The legend wizard 

uses these names to create titles so it is best to change them before you start. 

1. Click on the names in the Table of contents 

and change them to something more sensible. 

 

NOTE: The changes to the layer names are only 

saved in the MXD file, the names of the underlying 

Shapefiles will remain the same.  

 

 

 

2. Click on the Insert Menu and then select Legend. 

 

3. Make sure that only the layer you are displaying in the map is in the Legend Items. 

4. Use the Next button to advance through the wizard and click OK to finish. Once it is 

placed onto the map you can drag it somewhere suitable for display.  
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Part 5.3 Adding a North Arrow 

A map should also have a north arrow so that users know which way it is orientated. 

1. Click on the Insert Menu and select North Arrow. 

2. Choose one that you like and click OK. 

3. Drag the north arrow to position on the map, usually in one of the corners. 

 

NOTE: If you click on Properties in the 

North Arrow Selector you can do 

additional things like rotate the arrow. 

This is useful if you know that the 

projection or grid you are using doesn’t 

align exactly to true or magnetic north.  
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Part 5.4 Adding a Scale Bar 

Scale bars are essential for your map as they allow users to measure distances and 

understand the sizes of the features shown. 

1. Click on the Insert Menu and select 

Scale Bar. 

2. Pick the one you like the look then Click 

on Properties… 

 

 

 

 

 

3. Change the Division Units to 

kilometres. 

4. Optional: You can use the Label 

Position to move where the “Kilometres” is 

placed. 

5. Optional: Switch to the Numbers and 

Marks tab to change the format and 

position of the numbers around the bar. 

6. Optional: Switch to the Format Tab to 

change the colours and font and sizes of 

the text and bar. 

 

 

 

7. Drag your scale bar into position, usually at the top or bottom of your map. 
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Part 5.5 Adding a Copyright Statement 

There are times when you want to insert text to appear next to the map. A good example is 

source or copyright information.  

1. Click on the Insert Menu and select Text. This will place a tiny text box in the centre 

of the map with a cursor for you to type in some text. 

2. Zoom in using the  icon on the layout tool bar then switch back to the pointer  

to move the text box. 

3. You can type directly into the text 

box or double click on it with the pointer to 

open the Properties pop-up. 

8. Enter the following text:  

© Crown Copyright/database right 2014. 

An Ordnance Survey/EDINA supplied 

service. 

9.  Use Change Symbol… to change 

the font etc. 

10. Click Apply. You may need to insert 

some new lines to get the text to fit. 

 

The steps above are guidelines please feel free to explore all the options, and ask if there is 

something you can’t see how to do. Some of the other things you might like to try can be 

found by right clicking on the map and looking at the Data Frame properties. Here you can 

change the background colour and add things like a grid. 
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Note that when you save your work, you are saving the entire map document. To export your 

map layout to an image file: 

1. Click File then Export Map from the Menu. 

2. Note the variety of image formats available, you can create a PDF to take away and 

print at a later date. 

 

CONGRATULATIONS! 

You have now completed the ArcGIS Course.  

Please contact the Data Library or EDINA if you would like any more 

information about using GIS or Digimap data. 

Thank you for attending!  

 


